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A Development of ISO 19847/19848 based Data
Management System and Monitoring Application for

Shipboard Machinery Equipment

Woo, Yun Tae

Department of Computer Engineering,

Graduate School of Korea Maritime and Ocean University

Abstract

Recent ly, many researches are progressing to support the operation
and the maintenance works of vessels using analyzed result based on

various information of equipment.

However, there are limitations i1n terms of the expansion such as
the realtime check for the operation state of the equipment and the
analysis of the navigation equipment because the interface method

and the data protocol had not released.

The interfaces of communication equipment are standardized very
well, but the interfaces of machinery and other parts are not

standardized yet.

To solve these problem, the SSAP(Smart Ship Application Platform)
project was progressed 1in Japan 1in 2012, and the ISO 19847 for
shipboard data servers to share field data at sea and ISO 19848 for
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standard for shipboard machinery and equipment are established as the

result for this project.

In this paper, we developed a data management system for shipboard
machinery equipment and the monitoring application for the
verification of the utility, and we tested the data exchanging

using the developed platform based on the standards.

To do this, we analyzed the requirements of the standards and
related researches, and designed an architecture of shipboard data
management system that satisfied the requirements. Also, we
developed components of the designed platform architecture and

verified the effectiveness for it.

Key Words: ISO 19847, ISO 19848, Shipboard Data Management System,
Monitoring Application, Shipboard Data Management
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Trim Monitoring Routing = Monitoring Maintenance |

Onboard' machineries & Equipment
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(a) Without platform

Onboard applications & Shore

Optimum Performance Weather —I Engine Remote
Trim . Monitorin ‘ Routing Monitoring Maintenance

T I
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e
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Fig. 2.2 Application services
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SSAP ZZAEE F 20AZ APFHAT A HAE 20129 12€4 20154
3E7HA PP e F 3670 7ol FUbsiinh 3 F8 Ade % 21%
2ol 24 dlole AWl ALFAEA, A4 ol AW 7d & 8] 23 Ag, A
wh-gak e ZeE AA ISO 19847/19848(NP) 9] Algloltt, ==3F, F
HA = 2015 8HollA 2018 d7FA] zldston, 8 43 82 SSAP ISO
19847/19848(DIS) Al @ &5, SSAP Z2AE 7id &1, AlxEl AA 2 AAF
3} Soltt.

Table 2.1 Main action items in SSAP

Main Items Description

¢ Clarify requirements for Master Database by
Develop ) ] o
o studying necessary data input of existing
specifications of N = )
application services
Master Database and ) o
o * Design Master Database and its interface to onboard
its interface i -
equipment and applications

] * Prototype implementation
Implementation and .
] * Interface between Master DB and onboard equipment
trial of Master o
* Interface between Master DB and application

Database ]
* Share and onboard trials
Develop
specifications for * Clarify requirements for ship-shore information system
ship-shore * Prototype implementation and shore trial

information system

* Study association with other international standards
Standardization * Clarify scope of the ISO proposal
* Making WD for ISO proposal
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2.3 1SO 19847/19848(DIS) A7
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L A FEE S U HolE FA 2 AEAE Yo Bk

ole] ~Eg|W(Data Streaming)®} ©lo]E]l A (Data Stored oz TAH T =3
~EgW A% AH] 2(Streaming Transport Service), £3-3H A%
(Request-Response Transport Service), I} % AjH] 2 (File Transfer Service)
£ AT

0]E1 [SO 198489l 4 A 2lsl= quﬂpi}ﬁ Fﬂ 0]E1 g4 gld-g FAlsta, =
El= [EC 61162-450 dlo)E] 2 ISO 19848 3&xlo = FAlslm, 2+ 13
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2.4 MQTT(Message Queue Telemetry Transport) T2 EF

MQTT+ M2M(Machine to Machine), loT(Internet of Things) 53 #Zo] thdZ
o] & tulo]lxsof AP WA ZR2EFE FZo] B ¥ Y ESL I
M HAIRAE AR AEE & JAESE AAFHAT. =3, ALE ==
=2 djEF o], 2013\ OASIS(Organization for the Advancement of Structured
Information Standards)ell A I0TE {3 ¥+ ZZEZFZ WRIJUY. 18 24+
MQIT Z2EZ9 sAHAHo=m FAATE wAR wiZfAE Fs 54 WAA

£ TPsta FAAE HAAE FFEe e AR

ki

System Platform System
(SUBSCRIBER) (BROKER) (PUBLISHER)

Connect command

Subscribe request

/ MQTT
Connect ACK

Subscribe ACK

- Message

Unsubscribe request

4
Unsubscribe ACK /

Fig. 2.4 MQTT protocol communication process
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MQTTE @3tz e WAX 722 FAF 1, WAAY 4 =27)=
2byte2 WA|R] A7]oll= Aleko] Qe AHI WAA ZEEZo|th. & 2.2+
MQTTS WAA 2oz 1A dH, 7 sy 9 Hol=t A 7IA=2 T4 5
3, 1A Yo A= Message Type, DUP(Duplicate delivery) Flag, QoS(Quality
of Service) Level, Retain ¥ Remaining LengthE A o]stal 2712 nlolEZ
4.

Table 2.2 MQTT message format

0 1 2 3 4 5 6 7
Byte 1 Message Type buP QoS Level Retain
Flag

Byte 2 Remaining Length(1~4 bytes)
Byte 3

Variable Length Header(Optional)
Byte n
Byte n+1

Variable Length Message Payload(Optional)
Byte m

Message Typed] ZEF+ M/IAZE FAET 4719 HEE o] &3] WA

& Fgth DUP Flage "wIAAIZE S5 wAAIA], HF B #AA]
JAAE FAIGE QoS 2719 HIEE o] &3t ZAsta, & 237 Zo] F4
FFo wet 02GA R YFoxed], 02A s st mAA TS ALt
I AD ARE FAsA go, 19AdME s ol HARAE HALDEh
A=Ao)7 HAo] flernz FH HAF 2 & doh =9, 28AdAME e
AR S DDA HEM o) 7o) 9/171 ) Eo FHLE BAEY wA
A g Fal7t F43) 5ot} Retaine] A-$- 1719 HIEZS o] &3] F A3}
31, Retaing Atg3te] dlolg AF Al o WX] w7} 2poll w AR 7F A 7= o] A
2L FEAAN HAAE AFFH, 1 5SS F 2400 HYAT

Collection @ kmou



Table 2.3 Features of QoS

QoS | Bit 2 | Bit 1 Description
0 0 0 Forward a message only one fire and forget type
1 0 1 Forward a message more than once without handshaking
2 1 0 Forward a message only one with handshaking

Table 2.4 Features of retain

Retain value Description
False(0) Don’t send the latest message
True(1) Send the latest message

MQTTS] Publish¢} Subscribes EFS 7|Eo2 F4sta, EFLS &4
2 789 A% 72E 7Y, EES Y A2E ¥
A BEAH AT etk dE S0 A X &
o1 7HAE o, E9 Fx= 09 259 2o}

| Ship J / { Engine 1 J / Pressure

/ Temp

/ Temp

t
t

{ Engine 2 / [ Pressure
[

Fig. 2.5 Example for MQTT topic structure
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2.5 REST(Representational State Transfer) API

RESTE o] Az £9] 3 AFgHel Roy Fielding®] 20001 =EFof o3 #|-2
2NERa, B B HAS 8-S Bol AgsA Xasta vkar ddst

do] AHE HUg &8 F A= WEHI 71y of7Ig Aot &3 REST

ALdAFT22 Y ACIES ZE U&= Aoz vgofsto] Zh ko] o
3t URI(Uniform Resource Identifien)E& Fostx, sigd g o 24 <
GET, PUT, POST, DELETE WX EE& &3t A e]stH, REST §| AHl2=es= A4
o] URIE ¢l o’ ZgolAES F/RO aglel ) Z2EITE o] &3}
o HFZo] 7 Alnj~oltt

o r{r

REST 81 Ajulai 2H9 7]he] of7)ex) Taslo] Qon, A F4e) 42
W, B8, A2 542 /PR Yok =3 REST 9 Auats U
o)z, AR, AH WS D FiAR A /5P 2 B AT QYo

O Y3 el o] ~(Homogeneous interface) : HTTPOA A|&3h= 7]EA <1 4
A& o]-&3tM RESTOA zA-doll gk 522 3& 259} o] e %3], 784,

F7h 9 A F5g SR

Table 2.5 REST methods

Method Description
GET Create resource
PUT Select resource
POST Modify resource

DELETE Delete resource
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@ AAA(Connectedness) : 3F}e] AYL WMo AAd AISa A2
A3t T

oy
!
¥

+(Statelessness) : Eto|AEL] HEHE AHAA FE3A=
do Y3 A4S 7RIt
FA22 %9 7Fs3HAddressability) : EE A

42 1 4
, RE ARE URIZ AT}

A8 21Q1 URI©]
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A 3 A ISO 19847/19848 L TF-AFEF B4

B Aol A= ISO 19847/1984801 7]wkeh Auk Z]@#7 Holy wsg 9 #E
g o718l A AAIE 93l SO 1984734 ISO 198489 @ F-Abgkel s th&Eth.

3.1 ISO 19847 & FAM3F &4

ISO 198472 3jj/dolA = Ho|E
o3t A EFOE QAL LHEARI g:[L/\].ac}J—rJr Holg =8 o By @
FApgro 2 oAtk

o] OH
mlm
]
o
2
1z
jnj
i
o
g
R
=2
Yo,
ol
o

dukA ol @ FANGS 7 3.1 o]l A A A E TFA"ET

I

AR, A4 dolel Amel A% A%, & 329 o] Aut ojE AWl ¢
29 9 AN HolH A A Wad Ay dolg Ame A% a7
dal gelstn 9w, 7% LTS A%, Aol AE U, Holg

W B 4y 52 e gl

2

Table 3.1 General of requirements in ISO 19847

Category Requirement Description

Performance and | Processing, Storage, interface, conditi

function on monitoring, backup and alert

Power supply, vibration-resistant, ele
General _ ] ] )
Environment ctromagnetic noise-resistant, tempera

ture/humidity-resistant

Installation Environment, network security, etc.
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A% 7H], o]z vz So Eg& 9 FAEH

ARt Az717] ARl A ®F<1 [EC 60092

A, A= FFeles ARl Az=dA L mimdel o) &3t 5 24X 27
SOl AolHojok star, A HolH AWt AAHE= HE 4334 Heke A4k

A HES S AR Thol= E}?loﬂ A3k FF2U SO 164258 WHE5I=5 879t
A Sl

Table 3.2 Performance for shipboard data server

Performance
Input data 30 data in 1 session / 5 sessions in 1 seconds
Output data 30 data in 1 session / 5 sessions in 5 seconds
Streaming data 1 data in 1 sessions / 1 sessions in 1 seconds

dlolg oy 2 #e] a7ARRS: 3 333 o] =7 vl 7HA 7lsom FAETH

Table 3.3 Data [/O and management of requirements in ISO 19847

Category Requirement Description

System clock, data channel list and d
Data management ) ,
ata source information

Input, output, request-response, strea

Data I/0
Data 1/0 ming and file
and . . . .
Alias Common alias and user-defined alias
management

Data calculation | Max, min, average, etc
History of access, status changes an

Log management
d management data changes
- 16 -
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AR, Holy #AY 7|5 IA A 7HA 7]l E v

O Alz=" A7 #E] 752 dolHdd A& Bd=vlZE FU1str] 93l
UTC(Universal Time Coordinated)® %7]3} 5 ojotst Al7F Hxp=
o)’ YA gfolof g,

@ dolg Ad F=E #E 752 HolyH A=Y o Y3l A, A
2 FFo| Fojolstal Ao AZE E4 H vk HRE 7] E3H Q) HlolH
22 AR A J)e S A @R T uk ARE J|E3okstal, 4" 7]l
o3l A, F7F L AAVE Thssfokgtth =3, @A) oW HlolE AT} V|ESE
A8l A SFHA=A HEsHA e oFstth

=4, HolH A=Y 7le2 ZA A 7HA 7e e ydn.

B

21

N

|52 [EC 61162-1/2 ©lo]E 213} ISO 19848l olsl B 1t

& =
& Fgste] HolHE FAstL dY HOlEZF B 2"ZE TR SIA
B AT A4 dY HolEol Al=HE AZe] B2'xE FUhes Vs e
TPt

@ €9 7% [EC 61162-1/2 2 ISO 19848l 2Js) AH<ol® HolE 2 3
d 4= &8k HolHE AFske 75 e AT

© 84-5% HeolH AF Anlx 7] AZE EAHE JEE HolEE A
g8l 71%5S AFeta REST APIE At&ste] @A H dHolBE wgdot

29T Holg A% AHZx )5S st ool A4 AzxEl 2 g

| Z5t MQTT ZEEZS A3}

A\
N
o
B
ry
1o
)
i
o
uli
=
of
ol
ol
rlr
N
ofr
flo
R

o8& F4lgth
A, B3 7158 7153t @ o2& Ag3te] ol HZo] &ol3t=

L Aol Bxoln, 714 deje] 8

mit
ol
2

7502 vt
O &% ¥A 7le2 ¥59 EAES Aosiy A" € Ay AuE FF
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dolg o]Fo= HolHE HFst= 7Isolth

@ AHEA Aol ¥A Jee 54 HelHE At Aostal, tiAl olFL

Z HolEHE AEE Yl AeA Ao HAE wle:E I8 3

o

UiA, Hole A4k 71552 1SO 198489 BAlE =0l wet Al4bd HolHE

AR, 23 #8 7% W7 oy 9 dolH H AE 7Edoksi,

ol

i

Ol
=
oft
>
o~
)
1o
ol

9 IEC 61162 % Ae=Z 7o Holg Ao
7} FFsd e @R 2 7]E Auel HolE QlEHo| st EEH} ol
oo} 4% dolH mw# B BF B @ sl EAD
AT o FF TR B gt AH o] @ APEA 2 Holy Fxo] FH
Wal eld E29 SO 198480] S akAl ek
ISO 19848 3 FoA+= 3E 342 o] deolg ag md=z Holy z1d =g
3 AAL elole wae] tha) B o)k giek.

Table 3.4 Categorization of requirements in ISO 19848

Category Requirement Description
Universal [D(naming entity and ship ID)
Channel ID
Data Local ID(naming rule and local data name)

Channel Data Channel | Data channel type, format, range, name,
Property unit and remarks

Periodically | Numeric value from sensors / transmitter

Time Series | Updated Data | s and result of calculation

Data Irregularly Alarm information, status information and

Updated Data | manually input value
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D "oy g =4

Holg Ad 2d2 735 An 2 253t Ae] Yol AXd 24 AASY
ol ~Edo tigt A4 HARE A&k, A2ID(ChannellD)¢} Hol¥ A2
Loz FAEY. AA, AAID= HEIDWUniversallD)¢t ZID(LocallD)E Y
o olgjgk AdIDY F=E 19 3.1 YRtk

@O H&Ds 13 31 @9 == Aqt U dlolg A
oz 2ZAIDE A= NAE BEste 4L st

45 A3 93 54
= °]
149} IMO(nternational Maritime Organization) 2|85 %
T4

£ 70 A (NamingEntity) £+
< It Aol A

Zoh AMAE Agshs AUHDGhipD)sh 22D T4H,
@ 22DE 1931®L1?ZEAWLﬂﬂHiW%%E%ﬂHé1 a7] 9
§ mAoE Al GAE THLL 8 AxEe o] o5 Eolt @Rt

(NamingRule)®} Hw 2o wet As|z ol Ade] 28l =23 dHolg
o] E(LocalDataName) . & F-AH )},

UniversallD = [protocol]"//"NamingEntity ShipID LocallD
NamingEntity = authority

ShipID = Path-element

Path-element = "/" unreserved

Path-elements = Path-element | Path-element Path-elements

(a) Universal ID

Local ID = NamingRule LocalDataName
NamingRule = Path-element

LocalDataName = Path-element

Path-element = "/" unreserved

Path-elements = Path-element | Path-element Path-elements

(b) Local ID

Fig. 3.1 Channel ID structures
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©® Wlais doly Afdol the doje) Bk ARE dHsty A=dA, 73
| o= FAEH

AAG EolHE AzF EATE 7S, 24 5 A29 dolHE ofn
ol Az Aol wel ZAge] AP

Fot=u AHeEY, =714 dolg el vlFE7] A

@

7 5
=

i
A
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_Ol_ll
K
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o3t
By
ry
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filo
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7H Helgl= FHHOR ATHE AA AZ gt AL Azt gt 5o
.

@ MF/1A dolHt: OF Au, JE AR % £F 4Y e w3
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i

NAE dolHE st T e Aol EHolE e
=4 Axel dolE AL2rE $hHE HolEse %
ANE 17 3.20] eI
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iy
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o
)
o
ol
rlo

J% ofv]ste, olo] tha
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Timel

Data Channel A

(Syne Data) 1.0 0.5 10
Data Channel B

(Sync Data) 1.1 1.4 15
Data Channel C

(Sync Data) 101.2 - 103.5

Data Set(“Time1”, “1.0”, “1.17, “101.2”) l
Data Set(“Time2”, “0.5”, “1.4”, <)

Data Set(“Time3”, “10”,“15”, “103.5”)

Fig. 3.2 Relationship between data set and time series data

ISO 198489l 4= CSV(Comma Separated Value), XML(eXtensible Markup Language)
g JSON(Javascript Object Notation)¥} 72 Ao E 7|¥to 2 HolE FXE A9
a3 ol AdelsEs AAD HolHg TR

719 332 Hol Rdo =gF =& Uekd Zolm, 1Y 3.3 ()& Hlo]
H Ad #g2E 2do] =g4 75 el Zo= 7%, dd, vy A
g, 22D 3 £49 F A 84% FAHT H7|A = HwE HolH HEd
dleiet doly 2&< Hole ez FAFI, due doly Ade] 2
= AZIeE AgAe ARE st lon, HolH Ade 2ZIDet HA4C
2 7AEH. £ 2ZDe A9 W dHol Ade 4dEskr] f7 Ao

A2 Ao A= Aoskar Atk

)
o

ol

a9 33 e AAE dHeolH Rde =83 FxE Ued Ao= 97]x,
e, AAIE deld, Holy &, F7] HolH, olWlE dHelH, Holy Yt
2 HolH e & 87HA 242 FAEH AT HI7IAE= siEet AAE HolH
2 7459 e, s AALE dHelErE AdEE A7l Hely Ak
471t et = "E HolHE 7HAAL St AAIE HIoHE AIRE =2
AdEHE dHolHeY 555 Yea, HolH 52 dUlclE F7] o2 1

w3 HolH oot =3 7] HolHe Fr1Hoz dHelE d #e =

§|\

t
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o, o|HlE HolHE EFAAoR U olE ¥ & HF2olth Holy H

=
e YT BY2wzs} gE dole AFS olvstm, oleE A4 A
A e

Header

Data Channel List

Data Channel

Local ID

Property

(a) Data channel list

Package
b Header |
Header
—| Header |

4' Time Series Data |
1
: ﬁ Periodic Data |
! T| Data Set |
!

ﬁ' Event Data |
: T' Data Set |

(b) Time series data

Fig. 3.3 Logical structure of data model
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Al 4% Au 7185 Holy & Alzd" B EUEF
o ZEAlclA 2A

=
o
O
oy
—
—
N
8O
N
o
S
)
o
Al
=2
>
N
N,
)7
> o
e
o
do

4.1 #Zn A 3=s8 71y A

[EC 61162 ®lolE] F2& o|&ate] Holg AL A, Arlg AEE 5 3
A QL Weto] glo] B =A== 17 413 o] IEC 61162-1/2 A& 29| 5
RH Z =2l Transducer Do AHE 2B F = HolEHE HojA ddst=

& AR B O9 413 o] HolHE 7S A5 HolElE Aojd
ks O}Hﬂ‘r A Ao g duAe] oA ER, & =
o] ISO 19848 zEFollA AAIRE M4 ZERE FEI AH A8 A3 7]

e AR

rlr
4

u)
O

Mg

>
rr
u
o
N
Do
o
L

$ERXDR,P,2.5,P,Me/Lubrication/Lo/In/Press*45<CR><LF>

Fig. 4.1 Example of equipment identification code (before encoding)
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O% 4.2+ ZeAEAAE YeE L 5709 A< System, Component, Content,
Position, Iteme. 2 FAEH, F 7§29 ASCI A= FE=3}ste] £33} System
Z13E g AZAe|Ql 12712 F44 % a1, Component+= 11712 FAAET B3 1 9
U A AT ES ER/E TS SR7F Bot 1A o2 FAS] o«
Qo) we} FrFste] ARg-elfokgitt.

System Component Content Position Item
Index Name Index Name Index Name Index Name Index Name
BG(Bilge) Lubrication Systems CSW Aft CloseA
BF(Boiler Feed Water) Fuel Systems Bilge End Current
|2 BTZ Eallasl ‘Water Treatment) Cooling Systems BoilerWater FishRoom DevTemp
BL (Ballast) Air intake Systems BilgeSeparatedOil Forward Frequency
4 CD(Car Deck) 4 Exhaust Systems CFW 1 ForwardPort 4 FuelCommand
FA(Fire Alarm) 5 Valves and Heads Chemical 5 ForwardStarboard 5 Fuellndex
6 FO(Fuel Oil Valve) 6 Emissions Systems CompressedAir 6 In 6 Insulation
GR(GeneRator) 7 Mechanical Systems CondensateWater 7 Lobby 7 Leak
8 LC(Loading Computer) 8 Operating Systems ControlAir 8 Lower 8 Level
9 ME(MainEngine) 9 Battery System CvlinderAir 9 MeatFishRoom 9 LoadIndex
10 ML (Miscellaneous) 10 Emergency System 10 CylinderOil 10 MeatRoom LPress
11 PC(Pump Control) Out Position
[12 SG(Steering Gear) 2 DrinkWater 2 OutPort Power
3 Electric 3 PhaseR Press
ExhaustGas 4 PhaseT 4 Temp
FeedWater 5 Port Torq
6 Upper Vaccum
FOSlude Voltage
FW
HvdroOil
20 InertGas
Lo
2 LSFO
3 OilMist
4 HT
25 SW
26 LT

Equipment identification code Example
09 00 21 06 13 -> System(ME) Component(Lubrication Systems) Content(LO) Position(In) Item(Press)

Fig. 4.2 Equipment identification code table

O% 4.3 9 4.29] A I=RE FFs] &3 ool AHle] =
=l P ol

=7} “0900210613” ¢1 AS, 1

ZEGofollA HolEl AE A, tloly F4 F
Aol Aule] HolE A GA AEE S WUl ofY}, AR ¥R

2 Holge &7 =3 Ha3 & e A 7R

$ERXDR,P,2.5,P,0900210613*7E<CR><LF>

Fig. 4.3 Example of equipment Identification Code (after encoding)
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42 Aut 71 B35 dolg B opFYA 47

A AT E SO 19847/19848(DIS)S 7|wko.2 AAS 4lut 7] @R dlojg] B
AN 2El ol7|HIHE A getH I9 449 Za, A HolHE At dgst
= 5% dlolg #g] =E(ntegrated Data Management Module)=} *8]® d| o]
& AAst= dlolH AwW(Data ServenZ A H T}

T dolE #Y EE2 AAR AF 8
P2 oA olddA HlHE AlFsta, 2A
oA ZgAolddA TES 8AHT HolHE
AEL of &g Aol oAl REST APIE ©]&3le tlolE 84 A alid tolH
Agsta, gL AFol B-%, FIPE T3 3L FEH(CSV)= HolHE AlF3.

oy A=Y EF2 7|85 Ao TAstE old21 v HAE b9

2~ A (Interface Equipment)ell A TEC 61162-450 2o =2 H3E
g %, &% doly ¥ EEol| $4Astal, T TlolE #e EEL HoHE

T4l B Agste tlolE Aueol AR O $, Seide] 548 ofEEAlA
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— — — - Implementation Part

Ship Im T T T T T T T T T T T e e e e e e e e e e e e e e e e e e e e e m - =
1
: Monitoring
" Application
Shipb?ard : xowuson |
machinery I IEC 61162-450 (formatted data) csv
equ ip ment 1 (streaming data) (File data)
1
" " 1 ( ( v )
|
| MQTT REST API
AMS ! Interface Equipment Data Management Web Service FTP Service
cnerato (Alarm Monitoring System) Ml (IEC 61162450 Message Generator) Service Module Module Module
. 1
: 1 Data
1
Fuel Tank I Integrated Data Management Module Server
1
1
1
1 Data Management System
| \ J
[ | .. . S - N
IEC 61162-450(streaming data)
Shore XML/JSON (formatted data)

CSV(File data)

Shore based Shore based s Shore based Shore
Application 1 Application 2 Application n Data Center

Fig. 4.4 Designed system architecture based on ISO 19847/19848
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4.2.1 Qe o]~ AH] (Interface Equipment) A3 A

AA Aol AuEe F=golguz Auk g AujoA @AsE Ho)
HE IEC 61162-450 @240 2 7}g3ste] AEE = 9T st} ol <Y
ol AH|o] 7T & AZEYAE BASLZ] {8l [EC 61162-450 W AR A A
£2ZE S AR

HA R A= Zom [EC 61162-450 ¥Zo 2A] TAG/Sentence

31
2 745, “§” 9] UF-E-S TAG(Transmission Annotate and Group) -]
o

Sentence® A A dolHE 7FX 1 YT}

UdPbc\OSERXDR,P,2.5,P,0900210613*7E<CR><LF>

Fig. 4.5 IEC 61162-450 message example

Sentenceol| 4] “$” = Sentence®] AlZ}ojal “ER” 2 3 4.13 Zo] IEC 61162-1
ol A A o)t talker identifier® AXEo] RUHE A 2dolgls ouE 71x 1L
Atk “XDR” & ¥g7]o] SA S Snjstal, Uﬂ/\] A FA4L O9 4.6 Zo] T
et 53], Transducer D= 4184 AHst Ay 28 I=3) 7|HE
A%

A gshe] 1Y 473 o] AWAW IEEES ﬂzafs}oq East ]

Table 4.1 Classification of IEC 61162-1 talker identifier mnemonics

. Talker Transmission
Type of equipment . .
identifier group
Engine room monitoring system ER MISC
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XDR(Transducer Measurements)

$--XDR, a, X.X, @, C--Cpurvvvrnnnnn.. a ,X.X,a,c--¢ ¥ hh <CR><LF>

Transducer n’
Data for variable # of transducers

Transducer #1 ID
Units of measure, Transducer #1

—— Measurement data, Transducer #1
—— Transducer type, Transducer #1

Fig. 4.6 Classification of I[EC 61162-1 sentences

ME/Lubrication
/Lo/In/Press
(Local Data Name)

0900210613
(Transducer ID)

Fig. 4.2 Equipment identification code table

Fig. 4.7 Equipment identification code encoding process

[EC 61162-450 WAIA] A AZES o= I8 4.8 Zo] 4719 FH==
T ¥ Y. A A, DataGeneratorModule £ @2+ IEC 61162-1/2 dl°]H o] /a4
= O9 49¢ 22 A S T3 HAE & F AAHE HolHE Wy A&
o 7 % wHel] AA" wolEd)] [EC 61162-450 TAGS Z7}ste] A= dlo|g=
AAsH= 98-8 =33t} =4, DataGenratorForm S ~= AF&AF Q1 #H o] 2~
T4 2 AT [EC 61162-450 HlolHE HFdte 4= T AA, Net
-workManager &2+ IEC 61162-450 ©|o]E $418 $3 UDP 44 9 A

715 < 43833k, Udp_Connection®} Udp_DisConnection WA == FAHT 4l

(
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0%
o

A, Utility 222 dlol8l §a4e AZe] 93 Aade Adse o

5}a1, CreateCheckSum WA =2 FAHTH

i

DataGeneratorModule DataGeneratorForm NetworkManager Utility

+Msg +DataSendThread +Client

+random +generate +remoteEP +CreateChecksum()
oy +Period +Udp_Connection()

+CreateDatad50() +DataSend() +Udp_DisConnection()

+DataGeneratorModule()
+DataPreprocessing()

+Udp_Open_Click()
+Udp_Close_Click()

+MessageAdd_Click()
+MessageDel_Click()
+MessageMod_Click()

Fig. 4.8 Class diagrams of IEC 61162-450 message generator

Start
Create Sentence

<
%

Y

Exceed 79bytes?
(except $,<CR><LF>)

Correct Talker ID and
Sentence Formatter?

checksum after the

%30

The end of the
sentence with
<CR><LF=>?

End
Create Sentence

Fig. 4.9 Sentence generation algorithm for the IEC 61162-1/2 messages
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422 T tlolg #¥

25 (Integrated Data Management Module) A7

T oy #e EE2 Holy A%, dlole Y ~E #He H 4
ANZF A 7se Tk dHoly B AulA EE, 8F-3H A VsS
TRt §) Arlx BE 9 9dS AFste FIP AHl~ 288 7490

A, "oy # A¥lx BES 1Y 4103 Zo] 2072 FH2E AR
o 19 410 @+ F8 7IsES FY57] A% Szl 7 4100)=
dolg Ad g2E 2dS %“éﬁi Zzkg 913 Y 2o, 1% O« AR

A QB2 FHE S
st 2o 4

NetworkManager, ExcelProcessing

I__
—

1y

El

olf
l

cdlolg #E AMHls ZEAA F2 7
10 ()2 DBManager, DataChannelListManager,
2 Utility FH 22 FA DT

(a) Main Class

DBManager DataChannelLi g Networ Package DataChannelList Property FormatRestriction
+conn ToaacTaanaE A 1 ocaiE, +datachannelListField +datachannelField +dataChannelTypeField | | +itemsElementNameField
+setting aataChaanellis_Add() || qriclient +headerField +ormatField +itemsField

: +DataChannel_Add() vactting — HHormatriel
+ConnectionDB() +Header_Add() +Udpclient atachanne +rangeField
+DBManager() +LocallD_Add() P z g -
+DisConnetionDB v MOTTConnection, Header +locallDField +remarksField Unit

I [onDB0] +Property_Addg ;Mgmios"c:rfnﬁa%no FauthorField e il +unitField +quantityField

+UDPConnection() +datachannelListField PociiD +scaleFactorField
Utility ExcelProcessing +UDPDisConnection() +dataCreatedField DataChannelType | | +symbolField
+validChecksump| | F€omponent *Networkmanager) gshipiDFicld jgggpoyfngleld +calculationPeriodField
eckSUMO) | | +content o, +typeField Range
hottion ConfigurationReference +localD id [|[*uPgateCycleField +highField
+S) sxlen: +idField +haming ield +lowField
> +timestampField +PositionField Foramt
+ExcelProcessing() +SystemField prepr= "
+ProcessExcelData() restrictionFie
+ReadExcelData() +typeField

(b) DataChannel List Class

MainForm UserControl_ChannelList UserControl_Setting
- +_excelprocessing
+Ig§:§:é?r% +btn_Add_Click() +nelwor’i’<mar»age§J
+PerformanceCount +btn_Del_Click() +strData
+netRecCounter +btn_Read_Click() +UDPDataReceiveThreadFlag
+netSentCounter +btn_Generation_Add() +InsertData()

+UserControl_ChannelList_Load() +MQTTReceive()

+UpdateGauage1() +UserControl_ChannelList() +MQTTDataSend()
+UpdateGauage2() +UDPDataReceive()
+UpdateGraphi()
+UpdateGraph2()
+UpdateGraph3()
+UpdateGraph4()

Fig. 4.10 Class diagrams

Collection @ kmou

(c) Ul Class

of data management service module
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Hx DBManager Sdl2~& dolEn|o] 29 44 W A 7|ss Tyt
DataChannelListManager &&=+ dlolg @ Z2E #AHE {3 WIXE=E
TAEL, I8 41009 FUH=E AMEStY Holy Ade2ES Z474e) 74
[AE A= 7= 33t NetworkManager Z3 2+ IEC 61162-450 ©|
ol F4lS #1% UDP 94 % &4l 7= Fdsta, AU == S04 4
AZE dlolel 83 Al HolHE AFst= MQIT 942 92 Al 7ls<= 33t
Utility 32+ 218 [EC 61162-450 ©lo]E o] A TS AAksle] do]E 9
84S AAETE ExcelProcessing 23l 2= 4213+ [EC 61162-450 ©]o] €] <]
Yl WA =<l Transducer IDE 19 4.39] &AH] 2 I & Ho]ES o] &3}
039 #AL FPst=d 1 3RS 18 41137 o] FAHAT) o] 98 &
Hl 211 F& HolE&& v ¢loj9} AASt= ReadExcelData WA =9} T3
HA & F3Y3F= ProcessExcelData WA =2 A H T

ME/Lubrication
0900210613 / . \
(Transducer ID) \ m—) /Lo/In/Press

(Local Data Name)

fifid

el bl lelefel L
HHE A

Fig. 4.2 Equipment identification code table

Fig. 4.11 Equipment identification code decoding process
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4129} o] 15719 S22 FAEY, 18 4.12 (a)
ZFY2~oly, 18 4.12 (b)+= Time Series Data Model

MachineryContorller CreateFile Package DataChannel Data
+Data +config +headerField +idField +valueField
+list +datachannel +timeSeriesDataField +locallDField
+query +datachannelinfo
I +datagroup = z
+Delete() +dataset Header TimeSeriesData
+Get() d - =
i +data +authorField +dataGroupField
Post() +EventData :
+Put() +datachannelinfoField
+header +dataConfigurationReferenceField
+package +dataCreatedField DataGroup
DBManager +PeriodData +dataCreatedSpecified +eventDataField
corn +PeriodicData +dataModifiedField +periodDataField
+ResultData +dataModifiedFieldSpecified
+DBConnection() +ime +shipIDField
+DBDisConnection() +timeseriesData +timeField PeriodicData
+DBManager
gerQ +Createfile() +amountOfDataSetField
+CreateJSON() Time +dataConfigurationReferenceField
+CreateTimeSeriesData() +dataSetField
+CreateXML() +endField
+startField
(a) Main Class fuentbata
DataChannelinfo +amountOfDatasSetField
+amountOfDataChannelField igg:gggtnpf:g‘LéranonReferenceFleld
+dataChannelField
ConfigurationReference Dataset
TidFeld +dataField
+timeStampField +inkSigipField

(b) Time Series Data Class

Fig. 4.12 Class diagrams of web service module

g Arlz BEAA F8 75E Fdste Fdlae 19 4129 @ 3749
ZY 22 FA4¥ Y. MachineryController Z3@|2~= REST APIe] 7|5 AR %
3], 2HA|, A L A4 V)5S F3¥sta WAE=ZE Delete, Get, Post ¥ PutZ
¥t} DBManager= ©lolEnjo]=2] A4 2 A9 7]5S 433t DBOpen
9} DBClose HlIM=2 FAHt} CreateFile2 dolEjH|o] 20X 714 Ho|EZ
XML =& JSON FHE AFsF+= 75 FPFstH, Time Series Data 725 A
’338l= CreateTime-Series WA=, JSON EE|Z HHE A|-F3l= Create]SON A
t 9 XML ¥eiE HHE A g3t CreateXML WA E2 FALTH
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4.2.3 HoJe] Au|(Data Server) AA

dolel Aul SlEsol2 gulox A4 HolHE £ voly # 2E
o] Hole 2 AZESofolx 441 8 Azt AP 19 4132 Hlo]
Elulo] 2 T2 dolglmo] s o8 Mulno] ¥1, Hlo]Bwe 1SO 198489

A Ad ol Adel2~EY LocalDataNameo] Ht} Ho|E9o zZ ZHL
time, Transducer Type, value % unite. 2 FAFW, Z+ ZHo| ik Ao 7

4.29} #t},

— DB
time time time time
transducer type transducer type transducer type e oo transducer type
value value value value
unit unit unit unit

Fig. 4.13 Database table structure
Table 4.2 Column and description of database table
Column name Description
time save time
transducer type sensor type
value filed value
unit unit of field value
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4.3 EUHTE ojEgAolAd 24

RUHY ofFgAloldS AAE T dloly #e REY F8484S A5
7] sl EASAT. 19 414E Fes delolado e FHsR 74
- O =
Holdal, 19 414 @+ AHEA JdE ol FAS 9T FExola, 1F
4140)= AAZT AE Anl 2, 23-8H A AHl2= 2 3d AF Anjx 7]
e SR @ Fehzolnh
MainForm SettingForm HttpProcessing ExcelProcessing
+setting +manager THHpProcessing) +System
:TlJ;eadFiag +btn_Connect_Click() +ReguestDa[a()g :ggmgg?em
auery +btn_DisConnect_Click() +Position
+init_Graph1() +btn_SubScribe_Click() +item
+in}:_graprr1|§8 +glnt?Un;3ubSciibed_gIick() NetworkManager == =
+init_Gra| +SettingForm_Loa +ExcelProcessin
+im‘l:Gra3h4() +SettingForm(_) +_excelprocessing +Pr0cessExceIDgta()
+btn_Setting_Click() +;:Iient +ReadExcelData()
+Update_Graph1() +form
+Update_Graph2() Request\gRgomntrol +Dataparser) FTPManager
+Update_Graph3() +httpprocessing +MQTTConnection() -
+Update_Graph4() +DataParsing() +MQTTDisConnection() +ﬁ|?:2tleorigﬁﬂglata
- +RequestUserControl() +MQTTMsgSubscribeReceived()
FileUserControl +RequestUserControlLoad() +NetworkManager() :g?r\;miiieiﬁ?lao
+iles +Url_KeyDown{) +GetFi]eLisEtJ()
+ftpmanager
+btnDownload_Click() (b) Main Class
+btnGetList_Click()
+btnSave_Click()
+FileUserControl()
+FileUserControl_Load()
(a) Ul Class
Fig. 4.14 Class diagrams of monitoring application
F8 7%S FYss FYgas 19 414 (bE WA, HITProcessing 222
tolHE F4lste Q%# T3kl RequestData WA EE 53t

FAlgkt}, ExcelProcessing @l 2~ 11 4.113 o] [EC
E HadsFe 948 sta, v AE IERE
glojo} A Asl= ReadExcelData®} tlZd A4S 4-3)5}= ProcessExcelData ]| A
T2 FAH"h NetworkManager S~ AAIZE dlojg 418 93 MQIT A
4, A 2 FAshE 9gS 33tk FTPManager S8l 2~= FTP AHell H<&
4 3d xR 7|FE Fsta, FIP AW #Y g2EE 7MHLeE
GetFileListe} 3t¥ & O+ Z=3l= downloadedData WA =2 FAHT.

_34_

Collection @ kmou



A 5 Avp Z18E Holy #E AzHd ZUEY
ofE A 7 H AT

B ol A 4gel A AAT dold Tel Axd Wes EdE AxEe
Ao, RUHY o FeiAolde Ba) A A, 24-57 A%, Y A

2 =24 BgFe i e dHoly FHE Stk AR 71HR wHolg e
Nzee] g §4e & 513 2y EYAAE Microsoft Windows 10 Professional
64-bit, 7§t == Microsoft Visual Studio 2015, 7j¥t1oj= NET Framework
45 7]uke] CH#S 8k, Hole Mule) Z$- PostgreSQL 10 AH&38}]
TEHIAT. =R DA AE AHlzs MQIT Z=2EES ARSI, °ol&
218 Mosquitto lolHei2lE Fgstgom 23-89 M4 AulxE ASPNET
< &8st JfEstATh

Table 5.1 System development environments

Item Environment
oS Microsoft Windows 10 Professional 64-bit
Development Tool Microsoft Visual Studio 2015

Development language .Net Framework 4.5 based C# and ASP.NET

API/Library Mosquitto Library
DBMS PostgreSQL 10
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424N AT WE&S vRoRE A2HlY 72 FAQeASS JfEsiion,
a9 512 <
S84 A2e £357] Y8 ALI EC 61162-450 WA A WA LZE o]0
th. [EC 61162-450 WIAIA] A AZEgole] ALgA Qe Hol~E D 27 A
A F(Socket Setting), @ WA A 24 F(Message Setting) 2 @ WA|A] =HF
(Data View)=Z FAEo] 9o, B4 T2 EF2 UDP(User Datagram Protocol)
S AF83H IEC 61162-450 WA R & A A gkt

@ Socket Setting ®) Data View

| & 450 Message Eeneratoi \l/ = O X
Socket DataView

Clear 1000 w

P [ GOAEAm | — _—

PORT | 60001

Open Close

MessageSetting

Identifier Transducer Transducer Type Low Data High Data Unit of Measure Transducer ID
ER XDR T L't L W, | AtV ™| Add

5 13 |
“0904090613 Mod
(@ Message Setting

Fig. 5.1 IEC 61162-450 message generator

e

O &4 24 F+= UDP &74e AU 2+ 7]%—01 Row, [Pe} PORT+=
[EC 61162-450 = AojH dut vlo]g Z1&F<0 MISCell slg-3t= 239.192.0.1
7 60001 & A&ttt @ WAA A Fe dEstaA she WAA Ao
7Vsat™, IEC 61162-1/20014 A J3sl= wlolE g2ld uie} dHole& A3,
oo wet £ P AAVE 7tk Q HolH EYEe AA AEse
AR dolHE gR1d + o Heo mEt FAl F7]9 AAo] Jhesitt
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% 5.2 dolE ] Mulx g wdstdow O CPU AHE-3HCPU Usage),
@ RAM AM&-2HRAM Usage), @ Ethernet Al-&2(Ethernet Usage), @ A 12
B 93 A A=A Ael(Storage Connection Status), @ o]ty # = Aej(Ether
-net Link Status) ® UTC(Coordinated Universal Time) %713} <4 Aej(UTC Sy
-nc Loss) TdE0o] em, ISO 19847 EF=o QAR el whet Adt dlojy #

g AZHY AEE AATCE FAIRH.

@ CPU Usage

[
5@ Data Management Program

CPU USAGE \l'

b

RAM USAGE ETHERENT LINK STATUS

@ Storage Connection
Status

20000 |
Intel(R) S:ﬂwavs
Ethernet .. Loopba,
%\WO(\O &——® Ethernet Link Status
22
0 100

ETHERENT USAGE UTC SYN LOSS

@ RAM Usage

€¢——— ® UTC Sync Loss

e oD, 100:00:00

® Ethernet Usage

Fig. 5.2 Data management service module (main UD

a9 5.3 dHolyH Y AHl~ 2E9 Holy A g2E #HYE £% Ul
Z (O Header 2% X-(Header Setting), @ LocallD 24 ¥(LocallD Setting), @
Property A% X-(Property Setting), @ dlo]¥ H(Data View=Z T =] Ut
a9 34 @9 dHoly Ad Y2E AT =0 wet dgstixtste= Header,
LocallD ¥ PropertyE 243 3o Create(WA) HES F=2d XML 2o =
o] AAFET. =3 ADDF7H HES F2W HolE AAExErt F7hE 1,
Delete(2tA]) HES FE2H A oy Ad H2E FLo 71 HZ Hlo]
Bl xjdo] A" mAF e E Read Y ¢7]) HES F& % FdstaA

3= XML 39& Aestd @ dolE H(Data View)ol] EA 3Hch
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@ Header Setting

L& patg Management Program @ X
2 ®
Header Property(Format Type)
Ship ID IMO1234 ||| FormatType -
B Ct_af;"e' Author admin T . w ]
— isi o .
D DataChannelList xml | T ‘ 00 ‘ ® Property Setting
o seting [y R —
NamingRule i ‘ ScaleFactor 10 ‘
LocalDataName Imellubirication/lofin/press I quamiy [ pesswe |
System me J
— View
Component lubrication |
Content lo | <—— @ Date View
@ Local ID Setting e ] ®
tem press ‘
Property(DataChannel Type)
Type
UpdateCycle (Second) 05 |
CalculationPeriod (Second) 60 |
; N Create Add Delete Read

® Property Setting

Fig. 5.3 Data management service module (channel list UD

9 54% dloly g AHl2~ EE HolE A 9 FA 2FE AT A
HzlHo g Ul O dolgHuel~ A4 F(DataBase Setting), @ dlolE A%
A7 F(Data Store Setting), @ AAIZF dloJ8 AA F(Streaming Setting), @ d| |
Bl FData View= T4€ct. @ dlo)gulolx A% H&= HolE A 44 ¢
A7} 7hsstH S2E, AREAF o]F, PIEHE F HloEH|o] X o]Fo = %“35]
of ok @ Hloly A& A F= AEHo|x XA st Holy
%k [P 2 PORT AAo] 7bsstal 4l A4 H sfjA|7} 7hssith. Q ARt tﬂol
Bl A4 B= AAZE Holy $4Als A% 94 2 aiAZF 7hssta, [P 2 PORT A
A< HIEst] QoS, Retain 2 Topic A& o] 7Hssith. @ HlolH H+= 41% dlo]

Ele] 212 A7 2 dolHE mAF.
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@ Data Base Setting

Il & Data Management Program @ X
o)
{,} Home DataBase Setting Receive Data View
Host : .168.10. ime ata
N chanre ost [ 192.168.103 i oa
‘:1 List Username : ‘ postgres ‘ Connection

Password : \ ‘ DisC

Database : ship

g@ Setting

DataStore Setting

P [ 28919201 |
PORT : [ 60001 |
. e €T @ Date View
@ DataStore Setting Connection DisConnection ®

Streaming Setting

IP: [ 192168103 | QOs :[0:Atmoston |

PORT : 1883 Retain : [

Topic : 1 iricati i ‘
Connection DisConnection

A

® Streaming Setting

Fig. 5.4 Data management service module (setting UD

2 oojZgAlo|AddlA URIZ 84 A HolHE AFdic} &3], 1
o] 4L Z=w XML FHE HolEH= AZsta, 19 55 (b o] 4L
J

A7dstH JSON FEHZ dlo|E & A &gt

€ 5 Ty @ @ localhost:56914 b = 7. =&

JI#2 OI0IE &2l S 218t REST API A H 2 LICH

v

(a) Localhost:56914/Machinery/ME/Cooling/LT/IN/TEMP?type=xml
(b) Localhost:56914/Machinery/ME/Cooling/LT/IN/TEMP?type=json

Fig. 5.5 web service module
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9 5.6 EUETY ofEgAlelAdY Il AHEA QI HelxE O AAIRE
2= H(Realtime Graph View)e} @ MQTT A& RHMQTT Settingg® +A%
o @ 2AA 289z Fe MQIT Z22EES T8 FAlsts 2A% HelgE
TR FASE g ‘3}"’ @ MQTT 2# Re= 19 573 o] AAZE
tlolg] +4le 3 @ 4 H(Connection Setting)e} @ EZ A3 *(Topic
Setting= FA€EH. @ é FolAe AAZE b ] H FAS 9% P ¥
PORT AA< HIZEst QoS AAo] 7beslth @ B A FoAe F4lstaat
t= Arle) Ego] dAo] 7lssitt

a4 A
A4 4

i

O

@ MQTT Setting

@ Realtime Graph View

Engine Monitoring Program

O MainEnaine Lubirication Press O MainEngine Cooling HT Temp
-0—0—0—0—0—0—0—0—0—0—0—0—0—0—0—0-0 20—0—0—0—0—0—0—0—0—0—0—0000090

O MainEngine Cocling LT Temp O MainEngine cviinder in press
o—0——0—0—0—0—0—0—0—0—0—0—0—0—0-0 —0—0—0—0—0—0—0—0—0—0—0—0—0—0—0—00

Fig. 5.6 Monitoring application (main Ul

_40_

Collection @ kmou



@ Connection Setting

Settings _ o %
Connection
P: [ 192168103 | Pon: 1883 |
; @ Topic Setting

DisConnection

Topic

Host : [/Machinery ‘ U

Subscrib Unsubscribe

Fig. 5.7 Monitoring application (main Ul- MQTT setting)

a9 582 EUEH ofFgAleld e HlolE 83-8FS ATAHEA JIEH
ol2~2 O URI A% F(URI Setting)e} @ A& ez F(Static Graph View)= -
etk @ URL A R aFstaakst= Ao URIE YEste] HolBHE 8%
s olty. @ B4 Iz [+ URIE Bl 233 o8& Aste] iz

= EA5E 98e 9o

ﬁj Home

b @ Static Graph View

80
60

Fig. 5.8 Monitoring application (request-response U
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A 44 e gEHnA s FIP AW o, A84 oF 3 d=9s 43

o] b5tk @ HY BE K BA P& FIPAMS 31U 282 nejFe
.’I

Qs 3 Q@ HY R AR Fe 9d 55 Fol 3YS A8 & o,
1 olF H V& HAF1 OEEE ¢ F Atk
@ Connection Setting ® FileList View

L] - - -
— Engine Monitoring Program

Connection FileList ¥

FTP Server : |fp:// |

UserName : |_

Password : |

DownLoad

File Name : | |

File Size: | |

Download

Save

1

@ File DownLoad Setting

Fig. 5.9 Monitoring application (file transfer protocol UD
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5.3 Al2Hl AF

MRk Alz='e] F8&Al sl HAFshr] fsiA L™ 5103 Zo] HzE
AuElE st A3E st WA BA7AA HelHE st
A HolH #E AlzHelA Agsted EUEE oFgACldNA AR
, AR A=A HAFsAth. F& HZE 5L Holy A3 g
E g g, AAIRE HolH 84, 84-H e, Hd A 7lsolH, Ho|
B &g 289 753 F&o] AE sAst=A gl

Message Generator

v

Integrated Data )b - .
Management Module | ;' reaming

Monitoring
Application

Request-Response |

File Transfer

Data Management System Output Function

Fig. 5.10 Test scenarios for system verification
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a9 5112 Holg Ad g2E I Ao Ay=EA dHolH Ad g
o] FA4 @49l Header, Local ID, PropertyS &3 3o A HES F=29

Holg Ad g=E 29 722 XML 3do] AAHS FAT & Ut

1, &

) Data Management Program @ X

{3 Home Header Property(Format Type)
Ship ID ‘ IMO1234 ‘ FormatType Decimal %
Channel Author dmi
List { acmn | Low ‘ 10 |
D \ DataChannelListxml | High ‘ 100 ‘
o, ;
u@ Setting Local ID Symbol l Pa ‘
NamingRule | /Machinery ||| scaleFactor | 10 |
LocalDataName | /mel/lubirication/lo/in/press ‘ Quantity ‘ pressure ‘
System [ me |
— View
Component | lubrication |
<Format> ~
Content | lo ‘ <Type>Decimal</Type>
etion 1>
Position ‘ in \ /Format>
<Range>
T <High> 100</High>
item | press ‘ <|.fw> lu</Ln:S>
</Range>
<Unit>
Symbol>Pa</Symbol>
Property(DataChannel Type) StaleFacton 104/SealeFactar>
<Quantity>pressure </Quantity>
TyPE Inst - </Unit>
</Property>
</DataChannel>
</DataChannelList>
UpdateCycle (Second) 0.5 L /P;:ag;“"“ 3 5

CalculationPeriod (Second)

Delete Read

<?xml version="1.0" encoding="UTF-8"?>
- <Package xmins:xsd="http://www.w3.0org/2001/XMLSchema" xmins:xsi="http:/ /www.w3.0org/2001/XMLSchema-instance">
- <Header>
<ShipID>IMO1234</ShiplD>
- <DataChannelListID>
<ID>DataChannelList.xml</ID>
<TimeStamp>2018-12-17T21:59:27.1905102+09:00</TimeStamp>
</DataChannelListID>
<DateCreated>2018-12-17T21:59:27.1905102+09:00</DateCreated>
<Author>admin</Author>
</Header>
- <DataChannelList>
- <DataChannel>
- <LocallD>
<NamingRule> fMachinery</NamingRule>
<LocalDataName> /me/lubirication/flo/in/press</LocalDataName>
<System>me</System>
<Component>lubrication </Component>
<Content>lo</Content>
<Position>in</Position>
<Item>press</Item>
</LocallD>
- <Property>
- <DataChannelType>
<Type>Inst</Type>
<UpdateCycle>0.5</UpdateCycle>
<CalculationPeriod>60</CalculationPeriod >
</DataChannelType>
- <Format>
<Type>Decimal</Type>
<Restriction/>
</Format>
- <Range>
<High>100</High>
<Low>10</Low>
</Range>
- <Unit>
<Symbol>Pa</Symbol>
<ScaleFactor>10</ScaleFactor>
<Quantity>pressure</Quantity>
</Unit>
</Property>
</DataChannel>
</DataChannellist>
</Package>

Fig. 5.11 Test result of create data channel list file
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28 5125 7= dHolH Ad YP2Ee Holg AL 2713 AT A
Aetazt s dolE Ade FRnE JHD F ) WES Fw

do] F718< AT Yk,

fm

[, &% D O
ata Management Program (e) X
o ® < 9 Q
{3 Home Header Property(Format Type)
Ship ID [ IMO1234 ‘ FormatType Integer 5
Channel Author ;
List [ dmin ‘ Low [ 10 ‘
D [ DataChannelList.xml | ‘ 100 ‘
o N
pRESeting Local ID Symbol | & |
NamingRule [ /Machinery \ ScaleFactor l 10 ‘
LocalDataName [ /me/cooling/lt/intemp ‘ Quantity [ Temperature l
System [ me ]
- View
Component | cooling |
/DataChannelType> -
Content [ It ‘ <Format>
<Type>Integer</Type>
Position [ in | Resricion
R
ftem [ temp | e 00 Hiah>
<Low> 10¢/Low>
<fRange>
<Unit>
Property(DataChannel Type) <SymbalbC/Symbol>
<BcaleFactor> 10¢/ScaleFactor>
Type Inst - <Quantity> Temperature </Quantity>
</lnit>
<JPraperyy DataChannel>
UpdateCycle (Second) 05 (%2:‘;22:""9'“50 -
CalculationPeriod (Second) : —
| Create Add Delete Read

<?xml version="1.0" encoding="UTF-8"?>
- <Package xmins:xsd="http://www.w3.0org/2001/XMLSchema” xmins:xsi="http: //www.w3.0rg/2001/XMLSchema-instance">

- <Header>
<ShiplD>IMO1234</ShiplD> .
- <DataChannelListiD> - zDataChannel>
<ID>DataChannelList.xml</ID> - <LocallD>
<Tin‘;]estan;|p>2018-12-17T21:59:27.1905202+09:DO<_.’TIme <NamingRule> fMachinery</NamingRule>
</DataChannelListID>
<’I;)atECreatEd> 2018-12-17721:59:27.1905102+09:00</DateCri <LocalDataName=/me/cooling/It/in/temp</LocalDataName:>
<Author>admin</Author: cSyStem)lﬂacfSy?lem)
</Header> <Component>cooling</Component=>
- <DataChannelList> <Content>lt</Content>
- <DataChannel> <Position>in</Position>
- <LocallD> <Item>temp</Item>
<NamingRule> fMachinery</NamingRule> </LocaliD>
<LocalDataName> /me/lubirication/lo/in/press</LocalD - <Pr rt
<System>me</System> SRIOpET e
<Component>lubrication</Component> - <DataChannelType>
<Content>lo</Content> <Type>Inst</Type>
<Pasition>in</Position> <UpdateCycle>0.5</UpdateCycle>
<Item>press</Item> <CalculationPeriod > 60 «</CalculationPeriod >
</LocallD> </DataChannelType>
- <Pr°p§ﬂyéh " - <Format>
T s <Type>Integer-/Type>
<UpdateCycle>0.5</UpdateCycle> <Restriction/>
<CalculationPeriod>60</CalculationPeriod> </Format>
</DataChannelType> - <Range>
- <Format> <High>100</High>
«Type>Decimal</Type> <Low>10</Low>
<Restriction/> </Range>
</Format> - <Unit>
- <Range>
<E|igh>10l]<,t‘Hth> <Symbol>C</Symbol>
<Low>10</Low> <ScaleFactor>10</ScaleFactor>
</Range> <Quantity>Temperature</Quantity >
- <Unit> </Unit>
<Symbol>Pa</Symbol> </Property>
<ScaleFactor>10</ScaleFactor> </DataChannel>
<Quantity>pressure</Quantity> </DataChannelList>
</Unit>
<',pm";9dv> </Package>

</DataChannel>

Fig. 5.12 Test result of data channel add

_45_

Collection @ kmou



5132 7]& dloly A Y =EQ dHoly A&
A 7 FHZol AR ol 2do] AAES

&

5@ Data Management Program

2% Az A AHA)

g 4 9t

{3 Home Header Property(Format Type)
Ship ID \ IMO1234 ||| FormatType Decimal -
Channel Author admin
e ‘ ‘ Low [ 10 ]
ID ‘ DataChannelList.xml \ High l 100 ‘
o, -
5@ Setting Local ID Symbol | Pa ]
NamingRule | /Machinery \ ScaleFactor \ 10 \
LocalDataName ‘ /mel/lubrication/lo/in/press ‘ Quantity ‘ Pressure ]
System ‘ me ‘
— View
Component ‘ lubrication ]
[ <UpdateCycle>05¢/UpdateCycle>s A~
Content | lo | <CalculationPeriod> 60</CalculationPeriod>
</DataChannelType>
Position ‘ in ‘ <Formab>
<Type>Decimal</Type>
tem | press | o
<Range>
<High> 100</High>
Property(DataChannel Type) </<HL::;‘>U</L o
<Unit>
Type Inst - <Syrbol>Pa</Symbal>
<ScaleFactor> 10¢/ScaleFactor>
: <Quantity>pressure </Quantity>
<fUnit>
UpdateCycle (Second) 05 Aot o
CalculationPeriod (Second) 60 S
E Create =~ Add Read

<?xml version="1.0" encoding="UTF-8"2>

- <Header>
<ShipID>IM01234</ShipID>
- <DataChannellListID>
<ID>DataChannelList.xml</ID>
<TimeStamp>2018-12-17T21:59:27.1905102+09:00</TimeStamp>
</DataChannelListID>
<DateCreated>2018-12-17T21:59:27.1905102+09:00 </DateCreated>
<Author>admin</Author>
</Header>
- <DataChannelList>
- <DataChannel>
- <LocallD>
<NamingRule> fMachinery</NamingRule>
<LocalDataName> /me/lubirication/lo/in/press</LocalDataName>
<System>me</System>
<Component>lubrication</Component>
<Content>lo</Content>
<Position>in</Position>
<Item>press</Item>
</LocallD>
- <Property>
- <DataChannelType>
<Type>Inst</Type>
<UpdateCycle>0.5</UpdateCycle>
<CalculationPeriod>60</CalculationPeriod >
</DataChannelType>
- <Format>
<Type>Decimal</Type>
<Restriction/>
</Format>
<Range>
<High>100</High>
<Low>10</Low>
</Range>
- <Unit>
<Symbol>Pa</Symbol>
<ScaleFactor>10</ScaleFactor>
<Quantity>pressure</Quantity >
</Unit>
</Property>
</DataChannel>
</DataChannelList>
</Package>

Fig. 5.13 Test result of data
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Password : i DisConnection ggli:é:;%i 1::?%
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Connection DisConnection 218-12-17 2% 11:16:12

2018-12-17 2F 111603
2018-12-17 2% 11:16:13
A18-12-17 2% 11116114
2018-12-17 2% 11:16:14
018-12-17 2% 1116115
2018-12-17 2% 11:16:15
2018-12-17 2 % 11:16:16
2018-12-17 2% 11

Streaming Setting
IP: 192.168.103 | QOS : [0 Atmoston -/

1883 |

PORT : Retain : =]

216-12-17 2% 11
|eoig-12-17 2% 11
2018-12-17 2% 11
2018-12-17 2% 11:16:13
2018-12-17 2% 11:16:20
<

Topic : ;fMachineiryi 2l

Connection DisConnection

Data

UdPbcWOSERXDR.P.6.P.090021061 3+61
UdPbcWOSERXDR.P.7.P. 030409061 3-6E
UdPbcWOSERXDR.C.29.1.C. 0902260614+41
UdPbctB$ERXDR.C.8,6,C.0802241114-TF
UdPbcWOSERXDR,P, 9, 1,P 0S00210613+71
UdPbcWSERXDA.P.9, 1.P.0904090613+7F
UdPbcWOERXDR. C.14.4.C. 090226061 4-44
UdPbcWDSERXDR.C.6.4,C. 0502241 114-7D
UdPbc'WO$ERXDRA. P8, 1,P,0800210613-70
UdPbcWOSERXDR.P,1.5.P 090409061373
UdPbcWOSERXDR,C 64.8.C. 0902260614-41
UdPbcWISERXDR. C.20,C.0902241114-53
UdPbc#WCHERXDA.P.5,2 P.0300210613-TE
UdPbcWOS$ERXDR.P.1.5,P (S04050613+73
UdPbcWSERXDA. C.58,4.C. 090226061442
UdPbeWOSERXDR,C,36.4,C, 09022411144
UdPbcWDSERXDR.P.9,7,P.0300210613-77
UdPbc%0S$ERXDA.P.6.3 P (804080813+72
UdPbcWOSERXDR.C.35,2.C 0902260614+4C
UdPbcWOSERXDR,C 83.5.C. 000224111448
UdPbcWIERXDR.P.4.6.P,0900210613-78
UdPbc'#DIERXDA.P.2.7.P 080408061372
UdPbcW0$ERXDR.C 58,3 C 090226061444
UdPbcWOSERXDR.C76,C.0902241114+50
UdPbcWOSERXDR.P.3,1.P, 090021061378
UdPbc¥WOSERXDR.P.7.P, 030405061 3-6E
UdPbct%0SERXDA.C.17,5.C. 09022606 14-48
UdPbcWOSERXDR, C39,2.C 09022411 14+47
UdPbcWMERXDR.P 5.3.P 0900210613+ 7F
UdPbe¥OSERXDR.P.5.9.P 090409061 3- 7B
UdPbcWDSERXDR.C.0.C.0902260614-65
UdPbctO$ERXDR. C 46,2 C 09022411 14~4F
UdPbcWOSERXDR.P, 7. 1.P.0900210613«7F
UdPbe¥WO$ERXDR,P,8.2.P, 090409061 3-7D
UdPbcWOERXDR, .88, 1.C. 030226061444
UdPbcWDSERXDR.C.11.3.C.0902241114-4C

- mosquitto -v

Fig. 5.14 Test
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result of streaming data transfer (publisher)

g =2



Settings - o g q @ x

Connection
IP: 192.168.103 | Port : 1883 P ———
Qos : @ Connection

DisConnection

Connection

Host : |/ship/Engine

O MainEngine cyiinder in press

Subscrib | _ Unsubscribe

Connection
IP: 192.168.10.3 | Port : 1883 |

(O MainEngine Cooling HT Temp

QOS : |Atmostonce | Connection
DisConnection
Connection
Host : i.’Machinery

\/Machinery

O MainEngine cyinder in press

w

Fig. 5.15 Test result of streaming data transfer (subscriber)

Unsubscribe
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9 5162 24-8H TlolE AF E2E AFREA FTe URL 43l
Z3)5tax} sk URISE &4 A2 2018 11€ 10€(20181110), =< 2018

@ 114 1094(20181110)= A3t HolHE 2AstA W g 7|3 &< =

A9 dolHE $Hcl 1A FH AARAFE S HU T 5 Ak

b

N

Machinery/ME/Cooling/LT/IN/TEMP?starData=20181110& & endData=20181110

Engine Monitoring Program

/Ln} Home mtp:mocalhost.f)ﬁg14!Mach|nernyEﬂcoollng,‘LTiINfr EMP?startData=20181110&&endData=2018111(

‘-J:’F""' 3
=

& Fie ; /

m N

20

Reg-Res

2018111018:57.52 4813410  20181110165800.5237440 2018111016:55.08 5474160 | 2018111016:58:16 6013810

Fig. 5.16 Test result of request-response data transfer

a9 517 EJr?J_ Holy AF ZA3=2ZA 19 510 (@+= Holy HE A==
o] FTP AMul ol &35t o, A AAsta A= AAd tigk CSV 3 =
25 Jehath EE?&, a9 510 e L F Y gdS g2 st oy
solaf| i A2 A, TimeS dolEl7} AAA A7+ 9w dtar, Transducer Type
AAe F8& ovgth &3 unitd dlF AA ghe] ©9E o v gt

o ot
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L] - - -
= Engine Monitoring Program

{xr Home Connection FileList

Reg-Res

‘ tb_me_cooling_It in_temp.csv

FTP S T fp:
erver : fip://192.168.10.3 th_me_lubrication_lo_in_press.csv

@ = UserName : |wyt |

Password : [+ ‘

Connection

DownLoad

File Name : |tb_me_cooling_ht_out temp.csv |

File Size :  [12099 |

Download

(a) Result of file download

time transducertype  value  unit
2018-10-16 09:39:09.30192+09 C 13.1 C
2018-10-16 09:39:15.314881+09 & 33.6 k.
2018-10-16 09:39:21.325042+09 R 38.6 &
2018-10-16 09:39:27.334292+09 @ 96.6 C
2018-10-16 09:39:33.339285+09 C 22.3 C
2018-10-16 09:39:39.34756+09 C 233 c
2018-10-16 09:39:45.356389+09 C 69.4 C
2018-10-16 09:39:51.367178+09 C 24 C
2018-10-16 09:39:57.377886+09 C 19.5 L
2018-10-16 09:40:03.384765+09 C 30.3 C
2018-10-16 09:40:09.395958+09 C 13.7 C
2018-10-16 09:40:15.407059+09 C 51.9 C
2018-10-16 09:40:21.41688+09 C 321 &
2018-10-16 09:40:27.427121+09 C 871 B
2018-10-16 09:40:33.436018+09 & 69.4 C
2018-10-16 09:40:39.444528+09 C 239 C

(b) Result of file contents

Fig. 5.17 Test result of file data transfer
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